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1. INTRODUCTION
Thea for Rhino is an integrated plug‐in that enables u liza on of Thea Render rendering func onality within McNeel Rhino 6. The plugin enables a wide
range of features which include:
* Biased/Unbiased/GPU render modes (u lizing CUDA technology)
* Physically based material interface uniform of all render modes
* Produc on render and ﬂuid interac ve render
* Physically based environment (Sun/Sky)
* Physically based cameras and lights using Thea for Rhino interface

2. INSTALLATION
Download and execute the Thea for Rhino installer from the following link: www.thearender.com/downloads
Make sure you have administrator rights while installing the plug‐in; right‐click the installer ﬁle and select 'Run as Administrator'.
When you reach the 'Choose Components' screen, you can select whether you want to install samples for materials, ior/crf ﬁles, etc.
In the next screen, 'Choose Data Loca on' you can select the place on your hard disk where you want all this data to be saved.
A er this step, the Rhino Installer will begin installing Thea for Rhino. When the installa on is complete, click the 'Close' bu on and you are ready.
Important:
When installing Thea for Rhino you will be asked to set the path of the Thea Data and Thea Temporary folders to a loca on where every user has full read/
write access. If the path doesn't have proper permissions, the plugin will not work properly.

3. ACTIVATION
Lease License
A er installing the plug‐in, open the License form window from the main menu: Thea Render > License > License Form
1. Enter the Username and Password that you used to sign‐in to the Thea Portal.
2. Click on the "Ac vate" bu on to ac vate Thea for Rhino.
Note: The license returns to the server each me you close Rhino and it can be used on any other machine.
Oﬄine Mode: This mode borrows the license from the licensing server to the speciﬁc machine. The plug‐in will remain
ac vated on the machine without the need of an internet connec on. Maximum borrowing me is 14 days.
Note: You need to uncheck this op on if you plan to use the license on a diﬀerent machine though.
Use Proxy Internet Connec on: In case your machine is behind a proxy server, you need to enter the IP Address and Port of the Proxy Server. Username
and Password should also be ﬁlled if needed.
Important: All ac ons within the License window need an internet connec on. When Oﬄine mode is not ac ve, the plugin checks periodically the license
and if it cannot reach the server for up to 30 minutes, then watermarks will be introduced in the next rendering session.

Node‐Locked / Educa onal
If you have a node‐locked license, use this op on to ac vate Thea for SketchUp. A er installing the plug‐in, open the license
setup windows from the main menu: Extensions > Thea Render > License Setup
Click "Register Νow" and complete the form to receive your license ﬁle by email. To ac vate Thea, click on the "Browse"
bu ton and browse for your license ﬁle. The status is displayed at the top of the license form.
Note: If you don't ac vate your license, you will remain in Demo mode with certain limita ons.
Demo Version Limita ons: Please note that when the plug‐in is not licensed, the rendered image resolu on will be limited
(1280x720) and watermarks will be added. All other features and func onali es are fully supported.
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4. FIRST STEPS
A er the installa on and ac va on of Thea for Rhino there are a couple of steps that need to be done to have a be er
workﬂow when working with the plugin.

Making Thea for Rhino the default render
From the main menu select Render > Current Renderer > Thea for Rhino. When the plugin is the current renderer, you will be
able to see the new Thea Material in the Materials tab.

Thea Render (Display Mode)
By default, when rendering interac vely in the viewport, surface isocurves, mesh wires,
etc will be displayed. To disable them, go to the main menu Tools > Op ons > View >
Thea Render and from the Visibility rollout uncheck all the parameters.

Thea Render Se ngs Tab
To make the Thea Render se ngs tab visible, right click on any Rhino's tab and select
'Thea Render' from the list or use the main menu:
Thea Render > Render Se ngs

4
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5. USER INTERFACE
Thea Render Menu
A er installing the plugin a new entry will be available in the main menu called Thea Render.
Darkroom: Opens Thea Darkroom. This is where all the rendering takes place and is explained in
sec on 5.
Render Se ngs: Opens the Thea Render Se ngs panel.
Preferences: Some speciﬁc se ngs can be set through the Preferences window.
Tools > Archive Scene: Creates an archive in zip format containing the .3dm ﬁle along with all the
textures.
Tools > Update Dependencies: Sets the path where Thea will search for missing textures and update
materials accordingly.
Tools > Install Library: Opens Thea Library ﬁles (.lib.thea) and installs them in the Thea Data folder.
Tools > Import Render Se ngs: Imports render se ngs in xml format.
Tools > Export Render Se ngs: Exports current render se ngs to xml ﬁle format.
License Form: Opens the License Wizard window that allows the ac va on of Thea for Rhino.

Preferences Window
Default image save format: Choose the default image format to appear when saving a rendered
image from the Thea Darkroom window.
Image Save Period: Saves a copy of the image rendered in Produc on Mode in a temp folder for
backup. Deﬁnes the interval in which the image will be saved.
Frame Split: When this op on is enabled, the rendered image will be divided among all enabled
presto devices during interac ve render. This results in higher refresh rates during interac ve
render.
Cau on: Slower devices may slow down interac ve render, so leave this op on unchecked if in
doubt.
Pixel Block: Deﬁnes how 'blocky' pixels will appear during interac ve rendering. Higher values
give more ini al noise but have higher refresh rate.

Thea Toolbar
The Thea Toolbar gives you quick access to Thea for Rhino se ngs and panels.

Start Interac ve Rendering

Preferences

Ini ates Interac ve Rendering in the current ac ve
Rhino Viewport.

Opens the preferences panel.

Display Se ngs

Stop Interac ve Rendering

Opens the display se ngs panel. Useful when the
display needs to be adjusted during viewport
rendering. When this panel closes, it is docked to
the Darkroom window

Stops viewport rendering and reverts the viewport
to the last ac ve Rhino view.

Save Image

Content Browser

Saves interac ve render image. Interac ve
Rendering needs to be in progress for this to work.

Opens the Content Browser.

Darkroom
Opens the Thea Darkroom window.
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6. THEA DARKROOM
A

C

B

D
The darkroom is the main window used to render the scene and provides a lot of useful func onality which will be presented in the following sec ons. The
main sec ons of the Darkroom are: top panel, Render panel, the display se ngs tab, the channels tab and the Render Queue tab.
Panel A: The toolbar allows the user to perform several tasks like star ng/stopping a render, deﬁne render se ngs and edit the camera and materials in
the scene.
Panel B: This is the panel that render images are displayed. This panel is updated automa cally during rendering or when the display se ngs are adjusted.
Panel C: The se ngs panel has three tabs (Display, Channels and Render Queue) that can be seen in detail in sec on 5.
Panel D: At the bo om of the Darkroom window you will ﬁnd several informa on that have to do with the rendering process like samples per pixel.

Zooming & Panning
Zooming: Use the middle mouse bu on to zoom in and out.
Panning: Hold the Le Mouse Bu on to pan.
Zoom to 100%: Double click with the Le mouse bu on to bring zooming back to 100%.
Fit to window: When the image is larger than the viewing area you toggle between 100% and Fit to Window by double clicking with the Le Mouse bu on
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6.1. RENDERING WINDOW
Start/Pause

Pick Camera Focus

Starts rendering in the Darkroom. Once render has
been ini ated, this bu on is used to pause the
current render.

Select the point to which the camera will focus
during Interac ve Rendering.
Shortcut: CTRL+LMB

Stop

Pick Material

Stops the current render. During batch rendering,
the stop bu on will cancel any batches in the
queue.

Allows picking an object's
Interac ve Rendering.
Shortcut: ALT+LMB

material

during

Save Image

Region Render

Saves the image of the last render that was
ini ated.

Click and drag a rectangle region in the render
panel and render only the speciﬁed region of the
image.

Channels List
Select the render channel to be displayed on the render
panel. A channel needs to be ac vated in the Channels Tab,
before render begins.

Termina on Criteria
Sample Limit: Deﬁnes the samples per pixel to be
reached before the render ﬁnishes.
Time Limit: Deﬁnes the me limi in minutes to be
reached before the rendering ﬁnishes.

Render Engine
Select the render engine for the next render. Depending on the render mode
selected, only the available render engine can be selected.

Render Mode
Selects the render mode for the next render.
IR: Use Interac ve Rendering | PR: Use Produc on Rendering
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6.2. DISPLAY SETTINGS
At the Display tab we can see many op ons, which are related to the way we see the rendered
image.
These op ons can be separated in 5 categories: Exposure, Filtering, Camera Response Func on Glare
and Denoise.
EXPOSURE
Tonemapping: Select the tonemapping method that will be used. (Standard, Filmic, Reinhard Global,
Reinhard Local)
ISO: Deﬁnes how sensi ve the image sensor is to the amount of light present. A Value of 100 is
mostly used for exterior shots under a clear sky and Sun ligh ng. Higher values, usually between 400‐
1600 are used mostly for interior shots.
Shu er: Shu er Speed corresponds to the dura on a camera shu er stays open, measured in 1/sec.
Low values result in brighter images.
f‐number: The lens aperture is the ra o of focal length to eﬀec ve aperture diameter. Low values will
make the image brighter.
Gamma: The Gamma factor typically ranges from 1.0 to 2.5. In order to compensate for the
darkening of the image due to non‐linear output, we apply a gamma correc on scheme to the pixel
values before displaying the image.
Brightness: This parameter is used to compensate for a linear scaling of the image by a monitor.
CAMERA RESPONSE FUNCTION
Camera Response Func on ﬁles use real data provided by the camera manufacturers crea ng
realis c (nonlinear) display results, as if the image was coming out of the speciﬁc photo camera.
FILTERING
Sharpness: This is the most crucial ﬁlter for controlling the ﬁltering during downsampling the image
and it is advised to be enabled at default 50% value which is a balanced value between blurring and
sharpening. A value near 0% will produce a more blurred image while a value near 100% produces a
more sharpened image.
Burn: The burn value can be used to compress a High Dynamic Range (HDR) in a Low Dynamic Range
(LDR) image, presentable on screens and other limited range devices. Se ng burn to 100% means
that there is no compression.
Vigne ng: In photography and op cs, vigne ng is a reduc on of an image's brightness or satura on
at the periphery compared to the image center.
Chroma: This ﬁlter enhances the colors of the image as it is increased, ac ng as a satura on control.
Contrast: Determines the diﬀerence in the color and brightness of the object and the objects within
the same ﬁeld of view. 0% equals to a disabled control. 100% is the maximum value that can be set.
White Balance (K): Can be used to change the overall color balance of a render, so that it matches
the expected phenomenal appearance. A value of 6500K is usually used to balance ligh ng coming
from Sun and make white walls appear white, despite sun power being more yellowish.
Glare: Glare is the eﬀect when a high amount of photons arrives at ﬁlm, causing ligh ng to ﬂood also
nearby areas. The shape of the glare itself depends on the shape of the diaphragm.
Glare Type: Select how many blades you want. Radial equals to Bloom.
Glare Weight: Controls how intense the eﬀect will be
Glare Radius: Controls the length of the blades.
DENOISE
This is the built‐in denoiser of Thea Render.
Strength: Controls how much the denoising ﬁlter will aﬀect the ﬁnal image.
Details: Controls how much of the original detail of the image will be kept at the ﬁnal rendering.
Higher values will try to keep as much detail as possible.
Note: You can select between the Op x and the Non‐Local‐Means denoiser in the Thea Render
Se ngs. To enable denoising, make sure that you have the Denoise channel enabled.
PHOTOMETRIC ANALYSIS
Luminance and illuminance proper es of a scene are the two key factors in ligh ng design; they
describe the energy arriving to our eyes and space correspondingly, but in the way we, humans, perceive and interpret ligh ng.
Enable: Enables Photometric Analysis
Min/Max lum‐Illum: represent the range of the Luminance (cd/m2), as you also see in Figure 5‐98 and Figure 5‐99. By changing these values, the false
color image is being adjusted accordingly.
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6.3. RENDER CHANNELS
This tab is used when an addi onal image, other than a standard rendering, is required.
This is mostly used when you intend to do postprocessing using an external image edi ng
program.
Available channels are: Color (standard rendering), Normal, Depth, Alpha, Object ID,
Material ID, and channels speciﬁc to Adap ve (BSD) rendering mode (Direct, Ambient
Occlusion, Global Illuminaτιon, Subsurface Sca ering, Reﬂec on, Refrac on, Transparency,
and Irradiance). Some channels like Shadow Channel, Raw Diﬀuse Color, Raw Diﬀuse
Ligh ng, Raw Diﬀuse GI, and Self Luminance are only available for Presto engines.
Mask passes will only appear when you assign a mask to an object.
Depth Channel
Min/Max Z (m): Controls the minimum and maximum distance along the camera Z‐Axis.
Note: Depending on the ac ve render engine only the engine speciﬁc channels will be
displayed.
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6.4. RENDER QUEUE (BATCH RENDERING)
The Render Queue tab lists all the named views that have been created in the Named
Views panel.
By right clicking on a named view you can either edit its render se ngs or delete it from
the queue.
Edi ng Named View Se ngs
Edi ng allows the user to deﬁne se ngs per named view like resolu on, termina on

REFRESH
This bu on refreshes the list and syncs it with Rhino's current named views.
PROCESS
When all is set, clicking on the Process bu on will bring up a save dialog. Select the path
where your images will be saved, the image type (png, exr, ...) and ﬁnally the name. Thea
for Rhino will add the named view next to the ﬁle name you deﬁned.
A er that, Thea for Rhino will start rendering the render queue one by one in the
Darkroom window.
Note: Pressing Stop will terminate the whole render queue and not just the current batch.
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7. THEA RENDER TAB
7.1. RENDER SETTINGS
The Render Se ngs tab gives you access to all the rendering parameters.

Main
Render Mode: switch between Interac ve and Produc on mode
Engine: displays the engine list based on the render mode that is selected

Common
Supersampling: Corresponds to the supersampling used for the image output.
None ‐ No supersampling, Normal ‐ 2x2, High ‐ 3x3
Auto ‐ No supersampling in IR, Normal in Produc on Mode.
Mo on Blur: Enables mo on blur for all visible animated objects.
Displacement: Enables/Disables displacement for every object.
Volumetric Sca ering: Enables/Disables the rendering of par cipa ng media. If disabled,
Volumetric (Medium) and Sub Surface Sca ering (SSS) won't be rendered.

Engine Se ngs
This sec on displays the se ngs of the selected render engine. Find more details for all the
engines in Sec on 11.

Clay Render
Enabling this op on, all materials in the scene will be rendered as diﬀuse gray, giving the ﬁnal
image a clay eﬀect.
Reﬂectance (%): Increases/Decreases the diﬀuse material reﬂectance.

Network / Performance
Threads: they deﬁne the threads that will be used during rendering. Max corresponds to the
maximum number of logical cores on your machine.
Priority: Corresponds to the priority assigned to render threads by the opera ng system.
Network: sets render engine in single worksta on (None) or ac ng as Server, in network
rendering.
Port: Corresponds to the server port used by the applica on during network rendering.

Devices
In this area you will ﬁnd listed, all the compa ble devices that have been recognized by Thea
for Rhino. It is possible to enable/disable devices and also set their priority.
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7.2. ENVIRONMENT
PHYSICAL SKY
Turbidity: describes the sca ering of the atmosphere that is caused by haze.
Ozone: Deﬁnes the amoubt if ozone gas in the atmosphere. Values higher than 0.35 will give
the sky a blue color.
Water Vapor: Describes the amounf of water vapor in the atmosphere.
Turbidity Coeﬃcient: This is the power for exponen al transmi ance for atmospheric aerosol.
Wavelength Exponent: This number shows the average size of the par cles in the atmosphere.
Albedo:Albedo op on can inﬂuence the overall appearance of the sky. High albedo values can
occur for example in winter scenes by the snow reﬂectance while small values occur at
environment with grass. Especially in cases with high turbidity se ngs, changing the albedo
value changes the overall brightness of the sky.

UNIFORM ILLUMINATION
Color: Deﬁne the color that will be used to light the scene.
Intensity: Controls the overall intensity of Uniform Illumina on.

IMAGE BASED LIGHTING
Image‐based ligh ng (IBL) is a convenient way to add illumina on to your scene, coming from
captured photos of the surrounding environment. Since a photo of a real scene can be used,
the ligh ng is highly convincing and enhances the realism of your renders. In most cases, the
images used for this kind of ligh ng need to be of high dynamic range (hdr) in order to provide
enough ligh ng for a scene.
Texture: Specify the image you want to use for illumina on.
Wrapping: Speciﬁes the wrapping of the inserted image.
Rota on: Rotates the image according to the camera view we want
Intensity: Adjusts the intensity of the inserted image.

BACKGROUND MAPPING
We can specify the background mapping of our scene. This means that even if we have used
already an image for illumina on (which is also used as a background), we can now specify
another one for background and overwrite the one that was used.
Op ons are the same as in Image Based Ligh ng.

REFLECTION MAPPING
User can specify the reﬂec on mapping. If we do not enable this op on, reﬂec ons are
according to the map inserted at the IBL panel.
Op ons are the same as in Image Based Ligh ng.

REFRACTION MAPPING
The exact same things that we described at the Reﬂec on Mapping are valid for the Refrac on
Mapping panel.
Op ons are the same as in Image Based Ligh ng.

GLOBAL MEDIUM
Index of Refrac on: Speciﬁes the index of refrac on of the global space of the scene.
Absorp on Color: Deﬁnes the transmi ance color – this is actually the color visualized a er a
distance of 1 meter.
Sca er Color: Deﬁnes the sca ering color – this is the color that bounced par cles (in the
medium) have.
Absorp on Density: Deﬁnes the density of absorp on in 1/m units. The higher this density the
higher the absorp on.
Sca er Density: Deﬁnes the density of sca ering in 1/m units. The higher this density the
higher the sca ering.
Phase Func on: Deﬁnes the varia on of outgoing radiance over the sphere of direc ons and it
is the medium analog of a bi‐direc onal sca ering distribu on func on
Assymetry: deﬁnes the asymmetry parameter of Henyey‐Greenstein phase func on. This parameter is
unitless and takes values from –1 (totally back sca ering) to 1 (totally front sca ering).
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7.3. CAMERA
FILM
Resolu on: Clicking on the 'Sync Rhino Viewport' bu on to make the resolu on exactly the
same as the ac ve viewport window.
Width: Deﬁnes the width of the resolu on in Produc on Mode.
Height: Deﬁnes the height of the resolu on in Produc on Mode.
Local Aspect Ra o: Enabling this op on will lock the Aspect Ra o of the ﬁnal resolu on.
Focal Length: Changes the distance from the lens to the ﬁlm.
LENS
Projec on: Deﬁnes the camera projec on (Perspec ve, Spherical, etc)
Shu er Speed: Corresponds to the dura on a camera shu er stays open. It can be measured
in inverse me units (1/sec) correspondingly to grabbed frames per second.
Shi X: This op on helps us change the horizontal direc on of the current view.
Shi Y: This op on changes the ver cal direc on of the current view.
Diaphragm: Deﬁnes the shape of the aperture. (Circular or polygonal)
Blades: When diaphragm is set to polygonal, one can also deﬁne the number of blades.
DEPTH OF FIELD
Pinhole: by enabling the Pinhole op on, the f‐number of the camera is set to pinhole
(theore cally equals to zero and creates no Depth of Field at all).
f‐number: Deﬁnes the f‐number of the camera.
Focus Distance: Focus distance can be entered here or be visually deﬁned in Thea Darkroom
while in Interac ve Rendering mode.
Depth of Field: When enabled, it will ignore the f‐number set above and use the percentage
value below.
Value (%): Lower values create a shallower depth of ﬁeld.
Auto Focus: makes the camera focus at the center of the scene once enabled.
Z‐CLIPPING
Clip Near: Select whether you want to clip the scene using the near distance value.
Near Distance: Deﬁnes the near distance from the camera.
Clip Far: Select whether you want to clip the scene using the far distance value.
Far Distance: Deﬁnes the far distance from the camer.
STEREOSCOPIC
Distance: Deﬁnes the distance between the eyes in meters.
Projec on: Deﬁnes the projec on (Le /Right, Top/Bo om, Anaglyph, etc)
CONTAINER
Assign Container: A diﬀerent material can be selected as a container instead of Global
Medium for the camera.
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8. INTERACTIVE RENDERING
Thea for Rhino can render interac vely in both Thea Darkroom and Rhino's Viewports.
Rendering in Thea Darkroom
Rendering interac vely in Thea Darkroom is useful for systems with mul ple monitors as it allows you to have Thea Darkroom running in a separate
monitor while working on your project.
To start Interac ve Rendering, make sure that the op on IR (Interac ve Rendering) is ac ve and click on the start bu on.
Rendering in Rhino's Viewports
Thea is capable of rendering interac vely inside Rhino's viewports. To start rendering, click on the Start bu on of the Thea Toolbar. At any me, you can
either click on the Stop bu on to stop Interac ve Rendering or the Save image bu on to save the image that is currently being displayed in the viewport.

9. MATERIALS
Materials in Thea for Rhino can be created in the same way you create Rhino materials.
Important: To be able to see the new Thea Material op on, Thea Render needs to be the ac ve render engine.
From the top menu select: Render > Current Renderer > Thea Render
There are two ways to add a new Thea Material in the material list:
1. Click on the + icon in the material panel and select Thea Material from the list.
2. Click on the Thea Content Browser icon, select a material and either click on the Add bu on or double‐click
on it to add it in the material list. More details on content browser on sec on 8.2.
Edi ng Thea Materials
Thea for Rhino oﬀers two ways to edit Thea Materiels. You can either use Material Presets as a star ng point
or use the Advanced Material editor to have complete control over the material parameters and make use of
the advanced layering system that Thea makes use of.

9.1. MATERIAL PRESETS
Material presets oﬀer an quick and easy way to create most of the material you will need. The
available types are: Basic, Metallic Paint, Metal, Emiter, Mirror, Shadow Catcher, Thick Glass,
Architectural Glass, Thin Translucent, Lacquer, SSS, Gem and Plas c.
Depending on the preset type you choose, addi onal controls will appear in the editor.
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Material Presets Previews

Basic

Metallic Paint

Metal

Emi er

Mirror

Thick Glass

Architectural Glass

Thin Translucent

Lacquer

Gem

SSS

Plas c
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9.2. MATERIAL EDITOR
You can access the advanced material editor by clicking on the Edit bu on that can be found on any Thea Material. This will open a new ﬂoa ng window.

Advanced Material Overview

Material Preview

Material Name

Double‐click to enlarge preview.
Right‐click to load/save .mat.pack, .mat.thea ﬁles, and
select preview room.

The name will also change in Rhino's materials
panel

Layer Manager

Global Modiﬁers

Layers can be created, removed, change posi on,
assign a layer weight map and more.

These modiﬁers aﬀect the material as a whole.
Emi ance, Clipping, Displacement, Medium.

Layer Proper es
Proper es of the selected layer will be displayed
here.

Channel Proper es
Proper es of assigned colors, procedurals and
bitmaps will be displayed here.

Content Browser Access
Expands the panel to the le displaying the Content
Browser allowing the user to directly apply materials to
the current one.

Working with Layers
With the Layer Manager, you can create mul ple layers of diﬀerent type and weight.
Create a layer: click on the plus (+) icon, and then select the type of layer (Basic, Metal, Glass, Thin
Glass or SSS)
Change the type of a layer: Click the icon next to the le of a layer and select a diﬀerent type.
Deﬁne the weight of the layer: To change the layers percentage %, drag the colored horizontal bar. It
is also possible to use a bitmap as a weight map. Click on the checkerboard icon to the le of the
layer and load a bitmap texture.
Delete a layer: Select the layer and then click on the trash can icon.
Move a layer: Select the layer and then click on the up/down arrows.
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LAYER PROPERTIES
Below the layer manager you can ﬁnd the parameters of the currently selected layer.
Show advanced parameters: To display advanced parameters (Translucency, Micro Roughness, etc.),
click the hamburger menu icon.
Note: Diﬀerent parameters are available for diﬀerent types of layers.

LAYER TYPES
Coa ng Layer
The coa ng layer uses a special reﬂec on model with only the specular component. It is useful for simula ng varnishes and
paints on a layered material.
You can use several coa ng layers to simulate mul ple varnishes and paints. The coa ng itself reﬂects some light, while any
layers of material underneath absorb the rest of the light.
You can change the Ex nc on Coeﬃcient to modify the reﬂectance (based on Fresnel equa ons) and deﬁne the absorp on
density of the layers of material underneath. Both the Ex nc on Coeﬃcient and the Thickness of the layered material are
used to calculate absorp on at a microscopic level.

Basic Layer
The basic layer consists of a diﬀuse, translucent, and Fresnel based specular component. It is a highly energy eﬃcient material
designed to be used mostly for ma e and plas c materials.
You might also use basic layers to create metals and translucent materials. Metals, in most cases, have a non‐zero ex nc on
coeﬃcient, which corresponds to a high Fresnel coeﬃcient under any viewing angle.

Metal Layer
You can create a metal with perfect reﬂec on (Roughness = 0), a very rough metal (Roughness = 100), or something in
between.
The Bidirec onal Sca ering Distribu on Func on (BSDF) uses Fresnel equa ons for reﬂec ons, which is controlled by the
index of refrac on and the ex nc on coeﬃcient.
Set the Index of Refrac on to around 1 to make the material less reﬂec ve. As you increase the value, reﬂec on becomes
stronger and stronger; at very high values, the reﬂected light takes on the color of the selected color.
Use a non‐zero value for the Ex nc on Coeﬃcient to amplify reﬂec on.
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Glass Layer
You can create a glass with perfect reﬂec on and refrac on (Roughness = 0), a very rough glass (Roughness = 100), or
something in between. The Bidirec onal Sca ering Distribu on Func on (BSDF) uses Fresnel equa ons to balance reﬂec on
and refrac on, which is controlled by the index of refrac on and the ex nc on coeﬃcient. Set the Index of Refrac on to
around 1 to make the material less reﬂec ve and more refrac ve. Set the value to exactly 1 to make the glass perfectly
transparent. As you increase the value, reﬂec on becomes stronger and stronger; at very high values, the reﬂected light takes
on the color of the selected color.
Tip: To achieve perfect transparency, we recommend that you create a Thin Glass Layer instead of a Glass Layer with
Transmi ance enabled and the Index of Refrac on set to 1.
Important: Fresnel coeﬃcients are based on both the index of refrac on and the angle of incidence. Even with a very small
index of refrac on, the BSDF will be quite reﬂec ve for grazing angles. A real world example is a swimming pool. When you
look straight into the pool, the water is transparent; however, when you look at the pool from afar, the water reﬂects the
environment.

Thin Glass Layer
This glass model describes thin glass materials that show perfect (mirror) reﬂec on and transparency.
Thin Glass models are very accurate models and are great for assigning to thin surfaces, such as windows and thin transparent
plas cs. Although you could also use a glass material with transmi ance enabled and index of refrac on set to 1, it is
recommended to use the glass model whenever you want to achieve transparency.
Another way to achieve transparency is to actually model a surface, such as a window, as a thin double interface where
refrac on takes place at both sides. Using the glass model though is op mal in terms of visual accuracy and addi onally, it can
be traced during shadow evalua on (something like this cannot be done with the double interface model which will create
shadows). The glass model does not assume the model to be closed as it does not deﬁne an interior/exterior volume. The
index of refrac on is used as if the model was a double interface, in order to compute the overall transmi ance due to double
refrac on.

SSS Layer
The Bidirec onal Subsurface Sca ering Distribu on Func on (BSSDF) is a generaliza on of the Bidirec onal Sca ering
Distribu on Func on (BSDF); however, unlike BSDF, the entry and exit points for BSSDF may diﬀer instead of coinciding.
Therefore the evalua on of BSSDF is far more diﬃcult, as it involves the interac on of surface reﬂectance/transmi ance along
with sca ering through par cipa ng media.
Besides the surface reﬂectance entries, there are also parameters describing absorp on and sca ering inside the object. In
order for the SSS material to be evaluated correctly, the object should be closed (without holes).
Par cipa ng media with high albedo (i.e., when the sca er density is much higher than the absorp on density) are
par cularly diﬃcult to render. To accelerate rendering with minimum loss of accuracy, usually you can turn an asymmetric
medium into an anisotropic medium with a synchronous decrease of its sca er density. Assuming that the asymmetry of the
medium is g > 0, you can set asymmetry to the isotropic value of 0 and decrease the sca er density to a value that is equal to
the old sca er density mul plied by 1‐g. The new medium will have lower albedo, and it will render faster with minimum loss
of accuracy.
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Layer Parameters
Diﬀuse: Diﬀuse reﬂec on is when light is sca ered at several angles on a surface. You can select a texture, color, or procedural.
Layers used in: Basic
Reﬂectance: Reﬂectance is the texture for the specular component when you view the surface from directly above. Reﬂectance at the grazing angle (90
degrees) is also implicitly deﬁned. So, the specular reﬂectance is calculated as a combina on between user Reﬂectance and Reﬂectance 90 (white by
default), depending on the viewing angle.
Layers used in: Basic, Metal, Glass, SSS, and Coa ng
Anisotropy: Stretch and blur highlights against the grain of the material, which is par cularly useful for metals. For no anitrosopy, set the value to 0%. For
full anitrosopy, set the value to 100% (the material is a perfect reﬂector/refractor in one direc on and completely rough in the other direc on).
Layers used in: Basic, Metal, Glass, SSS, and Coa ng
Rota on (deg): To rotate the stretched and blurred highlights created using Anisotropy, enter a value from 0 to 360 degrees or select a texture.
Layers used in: Basic, Metal, Glass, SSS, and Coa ng
Roughness: Adds texture to the material at a microscopic level, aﬀec ng specular reﬂectance and transmi ance. 0% creates a perfect mirror reﬂec on.
Lower values produce crisper and brighter reﬂec ons. Increasing the roughness will spread and distribute reﬂec ons and create a more ma e surface.
Higher values produce bigger highlights and reﬂec ons that are more blurry and dim. At values approaching 100%, light becomes so sca ered that the
reﬂec ons are barely visible, if at all.
Layers used in: Basic, Metal, Glass, SSS, and Coa ng
Bump: Adds texture to the material at a macroscopic level. A bump map gives the illusion of texture without physically distor ng the geometry, minimizing
rendering me. Each layer of material can have its own bump map. The grayscale map tells Thea Render how to change the surface normals as if the
surface has been displaced; the modiﬁed normals are used in ligh ng calcula ons. A bump map looks like the inverse of what you might expect: black
represents the highest extreme and white represents the ﬂa est extreme, while shades of gray represent grades in between.
Layers used in: All
Normal: This is a more detailed version of bump mapping, where you select a RGB color image instead of a grayscale image. While standard bump mapping
uses grayscale values to describe the surface's hills and valleys in terms of height, normal mapping translates red, green, and blue values to x, y, and z
coordinates. This creates texture in terms of normal vectors up the hill or down the valley. Speciﬁcally, the red, green, and blue values (0 to 255) are
translated to x (–1 to 1), y (–1 to 1), and z (0 to 1) coordinates respec vely.
Layers used in: All
Index of Refrac on (n): When you place something behind a transparent object, it becomes distorted. The level of distor on is determined by the Index of
Refrac on, which deﬁnes how much light is bent and reﬂected when it comes into contact with a transparent surface. For example, air's value, 1.0, causes
no distor on of background objects. A value of 1.5 means that the background objects become considerably distorted (e.g., a glass marble). A value just
below 1.0 causes the object to reﬂect along its edges (e.g., a bubble seen from under water).
Layers used in: All
Ex nc on Coeﬃcient (k): This refers to light that is likely to be lost (i.e., to absorp on and sca ering). The higher the ex nc on coeﬃcient, the more
opaque the material. You can use a value of zero or above.
Layers used in: Basic, Metal, Glass, and Coa ng
Translucent: Make the material semitransparent by clicking on a texture. If no texture is selected, than no translucency will be rendered.
Layers used in: Basic
Micro Roughness: Adjust the sharpness of reﬂec ons, as the viewing distance goes from near to far. When looking at a surface that is completely rough,
planes that are closer appear rougher (because you can see them more clearly) while surfaces that are further away appear smoother (because you can't
seem them as clearly). You can adjust the Height and Width to deﬁne the average height and width (μm) of the bumps on the surface.
Layers used in: Basic, Metal, Glass, SSS, and Coa ng
Thickness (μm): This refers to the coa ng thickness. The thickness and ex nc on coeﬃcient are used to calculate the amount of light absorbed by any
layers underneath the coa ng.
Layers used in: Coa ng
IOR File: You can create a physically accurate material by using an Index of Refrac on ﬁle, which provides the exact index or refrac on and ex nc on
coeﬃcient for each wavelength of a material. The ﬁle extension is .ior or .nk.
Layers used in: Glass and Metal
Transmi ance: The amount of light that passes through a material.
Layers used in: Glass and Thin Glass
Absorp on (1/m): Change the absorp on density and color. You can use a value of zero or higher. The higher the density, the more absorp ve the
material.
Note: For a basic material, you need to select a color or a texture for translucency ﬁrst. For glossy materials, you need to select a color or a texture for
transmi ance ﬁrst.
Layers used in: Basic, Glass, SSS, and Coa ng
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Abbe Number: Can be used to create a rainbow eﬀect in the interior of an object, such as a gemstone. Without this rainbow eﬀect, gemstones would look
like glass. Lower values correspond to a stronger rainbow eﬀect. Increase the value for a more subtle eﬀect. You can look up the values for speciﬁc
materials online. The Abbe number describes the varia on of the index of refrac on with respect to the wavelength.
Layers used in: Glass
Interference: Makes a surface iridescent, simula ng a phenomenon called thin ﬁlm interference. You may have seen this in soap bubbles, oil slicks on
water, or peacock feathers. When light waves come into contact with a thin ﬁlm, some waves are reﬂected from the top surface while others penetrate the
ﬁlm, hit the bo om surface, and are reﬂected. When these light waves interact, momentary streaks of color result. The iridescent colors change when the
viewing angle is changed. Adjust the Thickness to change the irridescence level. 200‐1000 is a good general range for making a visible change.
Layers used in: Thin Glass
Sca ering (1/m): Changes the sca er density and color for a subsurface sca ering material. You can use a value of zero or higher. Note that the higher the
value, the longer it will take to render the material. The sca er color is used for both in‐sca ering and out‐sca ering light interac on.
Layers used in: SSS
Asymmetry: Controls the asymmetric coeﬃcient of a subsurface sca ering medium, which follows the Henyey‐Greenstein phase func on. You can use a
value between –1 and +1, where –1 corresponds to a perfect back sca ering media, +1 to a perfect front sca ering media, and 0 to a isotropic media.
Layers used in: SSS
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ASSIGNING COLOR, BITMAPS OR PROCEDURALS IN A CHANNEL
For each channel (e.g. diﬀuse, reﬂectance, etc) the user can assign a color, a bitmap texture or a
procedural. Clicking on the pale e icon to the right of each channel will display the list with the available
op ons.
Color: Use the color selector to deﬁne the RGB values of the color. Color also has the Spectrum op on
that allows you to deﬁne RGB values in the visible spectrum.
Bitmap: You can use tonemapping (Gamma, Satura on, etc.), change the projec on, and mix the bitmap
with a color.
Procedurals: Procedurals have their own customizable se ngs.
Temperature: deﬁnes the color of the emi er in Kelvin. (Avalaible in emi ance tab)

EMITTANCE TAB
Thea Render supports both area and point light emi ers. The area emi ers are applied to a
surface. Typically, the area emi er has a diﬀusion‐like emission model and it uniformly
distributes light along all direc ons in the above hemisphere. Nevertheless, more complex
emission models can be deﬁned by making use of an IES ﬁle.
Color: User can deﬁne the color of the light with the following op ons: Color, Temperature,
Bitmap and Procedural.
Power: Deﬁnes the power of the emi ance
Passive Emi er: The emi er will not cast light into the scene but one will s ll be able to see
the area emi er "lit".
IES Emi er: To convert a Standard Emi er to IES, click on the "hamburger" icon and select
IES Emi er.
Eﬃcacy: Maximum eﬃcacy is 683lm/w which corresponds to lights with no energy loss, meaning that all their power is converted to visible light.
Custom Light Evalua on: Custom Light Evalua on allows the user to select which components (such as Diﬀuse, Translucent, Reﬂectance, Transmi ance,
and SSS) will be evaluated for a given material and light, thus removing unwanted contribu ons and accelera ng render mes.

CLIPPING TAB
Clipping is a procedure that 'cuts' parts of the material based on a given texture. White/
Bright areas of the texture are kept while black ones are cut.
Texture: Select the image that will be used as clipping map.
So Clipping (Default): The so op on respects the alpha channel of an image and will use
all the grey values to clip the material.
Hard Clipping: Combined with the threshold parameter, it is posibble to select which parts
of the image will be used to clip the material.
Threshold: Se ng the percentage very low, only total and some very dark ones will be
'cut'. Increasing it, brighter areas will be used for clipping. Se ng the percentage to 100%,
the whole material will be clipped, as even the total white areas will be considered as
points of clipping.

So Clipping

Hard Clipping at 25%

Hard Clipping at 60%
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DISPLACEMENT TAB
Displacement is a technique that uses a texture or height map to cause an eﬀect where the actual geometric
posi on of points over the textured surface are displaced, o en along the local surface normal, according to
the value the texture func on evaluates to each point on the surface. It gives surfaces a great sense of depth
and detail, permi ng in par cular self‐occlusion, self‐shadowing and silhoue es; on the other hand, it requires
the most rendering me of this class of techniques owing to the large amount of addi onal geometry.
A displacement map is a black/white map like a bump map and the gray values of this map represent how Thea
should displace the mesh.
Displacement: Select the image that will be used as a displacement map.
Subdivision: Deﬁnes the mes the actual mesh will be subdivided. Large values will create a more detail
surface.
Height (cm): Deﬁnes the height of the displaced surface in cm. The maximum value will be used for the white
areas of the displacement map.
Center: Areas with black mean no displacement and white 100% displacement (corresponding to the height
you have ginen). This is true when center is set to 0, but if you change to 0,5 then 50% gray color of the
displacement map will represent no displacement and when set to 1 then 100% white will represent no
displacement (in other words it will displace the opposite way).
This inverted displacement is some mes useful, like for the ground plane displacement where you want to
avoid intersec ng with objects that are on the ground, as for example a car wheel that is on a displaced ground,
so in this case you would set the center to 1.
Normal Smoothing: This op on should be enabled for surfaces with smooth edges. For models with sharp
edges (box, plane, etc) it should be disabled.
Tight Bounds: Helps to render faster but ini aliza on will last longer. This is more preferred to have it enabled
Tips: A good mesh topology always helps displacement to work as expected. A pre‐subdivide surface in the
modeling applica on will make displacement work more eﬃciently.
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MEDIUM TAB
True volumetric sca ering is supported and Thea Render can solve light transport problems that include
par cipa ng media. There are a lot of possibili es since mediums can be both homogeneous and a lot of
supported phase func ons.
Absorp on Color: Deﬁnes the transmi ance color ‐ this is actually the color visualized a er a distance of 1
meter (assuming unit density and no sca ering). When the distance is less than 1 meter, the color shi s
towards white and when the distance gets bigger, the transmi ance shi s towards black. The color change
with distance is strongly non‐linear and thus it is recommended to avoid highly saturated colors.
Absorp on Density: Deﬁnes the density of absorp on in 1/m units. The higher this density the higher the
absorp on. This op on gives easy control to the magnitude of absorp on and it is possible to set a procedural
texture in order to deﬁne spa ally varying absorp on (heterogeneous medium)
Sca er Color: Deﬁnes the sca ering color ‐ this is the color that bounces oﬀ of par cles (in the medium). The
sum of absorp on and sca er color (multplied by their corresponding densi es) deﬁes the extnc on
coeﬃcient of a medium which is used to calculate the total absorp on at a distance. The sca er color may be
applied numerous mes for par cles that bounce inside the medium (especially for highly sca ering medium)
and so, it is also recommended here to avoid highly saturated colors.
Sca er Density: Deﬁnes the density of sca ering in 1/m units. The higher this density the higher the
sca ering. This op on gives easy control to the magnitude of scaterring and it is possible to set a procedural
texture in order to deﬁne spa ally varying sca ering (heterogeneous medium)
Phase Func on: Deﬁnes the varia on of outgoing radiance over the sphere of direc ons and it is the medium
analog of a bi‐direc onal sca ering distribu on func on (which is used for surface). The available func ons
are the Isotropic, Rayleigh, Mie Hazy, Mie Murky, Mie Retro or Henyey Greenstein (you can also set the
asymmetry value below it). Most used phase func ons are Isotropic and Henyey‐Greenstein.
Assymetry: Deﬁnes the asymmetry parameter of Henyey‐Greenstein phase func on. This parameter is unit‐
less and takes values from –1 (totally back sca ering) to 1 (totally front sca ering). Obviously the extreme
values of –1 and 1 do not actually sca er light outside the par cle direc on and they are not of prac cal use.
A value of 0 is balanced sca ering between back and forth direc ons and it is the same as using an isotropic
phase func on.

GENERAL TAB
General tab gives access to the shadow catcher op on and Custom Light Evalua on.
Shadow Cathcer: this op on can enable a material to be a shadow catcher or not. This feature is used to
integrate a model into a scene with a background image as with the Shadow Catcher, we introduce realis c
shadows produced by IBL, sun and Thea point lights. In addi on to these enhancements the shadow catcher
can produce real reﬂec ons on ground plane. To enable real reﬂec ons, we add a basic layer to our ground
plane and add a reﬂectance color.
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APPLYING MATERIALS WITH CONTENT BROWSER
The Advanced Material Editor allows the user to apply materials
from the Content Browser to the material that is currently being
edited.
To expand the content browser panel, click on the black arrow at
the le side of the material editor.
Note: More info on the Content Browser on sec on 8.3

Loading a material
Double click on any thumbnail to load the material in the editor.

Preview material before loading
It is possible to preview a material before loading it into the
material editor. To do that, follow these steps:
1. Start Interac ve Rendering in Rhino's Viewport or in Darkroom.
2. Click on the 'Interac ve Preview' bu on at the bo om of the
material editor to go into Preview Mode.
3. Select any thumbnail with a single click and you will instantly see
the material being applied to the scene.
Turning of the Interac ve Preview bu on will revert the material to
the previous one.
While in Interac ve Preview mode it is also possible to double click
on a thumbnail and load it into the current material.
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9.2.1. TEXTURE EDITING/LAYERING
TEXTURE EDITING
The texture edi ng tool has two modes to work with, Overview and Edit Mode.
Overview: the user sees only the parameters that have been modiﬁed while hiding the rest.
Edit: The Edit mode displays all the available parameters for bitmap edi ng like Texture Proper es,
Tonemapping and Coordinates. Any parameter changed here will be displayed in the Overview Mode.

Edi ng a Bitmap
By default, the Thea Material editor is in Overview Mode, displaying only the path to the ﬁle and any
parameter that has been modiﬁed allowing you to have quick access to the most used ones.
To start edi ng the bitmap, click on the hamburger icon and select Edit Mode.

Texture Proper es
Projec on: this op on helps the user select the projec on needed for the selected texture. From the drop
down list that appears by pressing the down arrow, a projec on can be selected among: UV, Cubic,
Cylindrical, Spherical, Flat, Front, Shrink Wrap, Camera Map, Cubic (Centered) and Flat (Centered).
UV Channel: we see here a list of all available Channels (for example the Diﬀuse, the Refrac on, the Bump
Channels etc.) and each texture can be linked to a selected channel.
Channel: two main channels exist for a texture, the RGB channel and the Alpha channel.
Interpola on: here the user can specify the type of interpola on for the selected image. It can be set to
None, Bilinear or Trilinear.
Repeat: when enabled, it forces the bitmap texture to le in all direc ons.

Tonemapping
Invert: this op on, inverts all the colors of the texture to their complemented colors.
Gamma: user can edit here the Gamma value of the selected texture. These values range from ‐100% to
100%. In the next images, we see these values for the selected texture and the way they aﬀect its ﬁnal
appearance.
Satura on: user can change from here a texture satura on, by giving it values from ‐100% to 100%. At the
next textures, we have applied two extreme values for satura on, to see how they aﬀect the tone of the
texture.
Brightness: another feature that aﬀects a texture tone is the brightness. Once again, values range between
‐100% and 100%. Brightness set to ‐100% makes the image total black.
Contrast: user can specify here the value of contrast that the texture will have.
Clamp Min and Max: from these two op ons, user can specify the minimum and maximum clamp of the
selected texture accordingly. RGB colors range normally from 0 to 255. By se ng for example minimum
clamp 20%, the colors that their RGB values are less than around 51, will be “cut” and get this value. By
increasing minimum clamp percentage, image turn to be whiter, while by decreasing the maximum clump
percentage, image is ge ng darker colors. Decreasing the maximum percentage and increasing the
minimum on the same me, textures tend to appear grayer, as gray color has RGV values around in the
middle of the 256 colors (128, 128, 128).

Coordinates
Oﬀset X and Y: Oﬀsets the bitmap over the X and Y axis.
Spa al Size (X and Y): Spa al Size is used to correctly account for scaling when changing from UV to Cubic
coordinates, while UV Scaling aﬀects the scaling once UV projec on is used.
UV Scale X and Y: Scales the bitmap over the X and Y axis.
Rota on (deg): Rotates the UV coordinates.
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TEXTURE LAYERING
Textures can be layered and blended together to generate complex results using any bitmap, color or
procedulars as layers.
To start layering textures, select a channel (Diﬀuse, Reﬂectance, etc) that has a color, bitmap or
procedural assigned to it, and from the Channel Proper es panel, click on the hamburger icon and
select "Mix with...".
The available op ons to layer with, are: Color, Bitmap and Procedural.
A er clicking on the 'Mix with..' op on, you will see the two texture layers one on top of the other.
Dele ng and moving layers is exactly the same as in Layers.
Each layer (except the one that is at the bo om) has two blending modes. Mul ply(*) and Add(+). You can switch between them by clicking on the
corresponding icon.
When the blending mode is in Add mode, it is possible to also adjust the layer percentage.
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9.3 CONTENT BROWSER
Thea for Rhino comes with ready to use materials in categories. To
open Content Browser click on the folder icon on the Thea Toolbar.
The le side of the window is divided into three main categories:
Materials, Online Repository and Custom Folders.

Materials
This sec ons list all the materials in categories that are locally saved
on your machine.

Online Repository
The Online Repository gives you access to thousands of Thea
materials from Thea Render's online database.

Custom Folders
It is also possible to deﬁne custom folders with Thea Materials on
your hard drive. Right click on the Custom Folder tle and select
Add. This will prompt you to select the folder in which you have
your Thea Materials collec on.
To remove a custom folder, right click on its name and select Delete.

Adding Materials in the Materials panel
There are two ways to add a material in the material panel.
1st: Double clicking on a thumbnail will load the selected material
in the material panel.
2nd: Select the material and then click on the Add bu on.
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10. LIGHT PROPERTIES
Thea light proper es can be conﬁgured from a separate dialog. When a light is clicked in the
Rhino viewport, the Thea light proper es page is shown in the proper es page. Depending on
the light type, the appropriate controls are shown.
Light proper es are divided in ﬁve categories which are: General, Emi ance, Advanced BSD,
Custom Light Evalua on and Container.

General
Color: Sets the color of the light.
Power: Deﬁnes the power of the emi ance along.
Units: Deﬁnes the units that will be used for the given power.
Eﬃcacy: Deﬁnes the energy loss of the emi er. A value of 683 lm/W corresponds to lights
without energy loss.
Passive Emi er: The emi er will not cast light into the scene but one will be able to s ll see
the emi er 'lit'.
IES: Loads and IES ﬁle. IES ﬁles describe light's emission according to measured goniometric
data.
Filename: The path to the IES ﬁle.
Mul plier: Modiﬁes the intensity of the IES light.

Adap ve BSD
Min/Max Rays: Deﬁne the eﬀors of the direct light es mator for the par cular light.
Global Photons: Deﬁnes if the selected emi er will be used for Global Photons.
Caus cs Photons: Deﬁnes if the selected emi er will be used for Caus cs Photons.

Custom Light Evalua on
Custom Light Evalua on allows the user to select which components (such as Diﬀuse,
Translucent, Reﬂectance, Transmi ance, and SSS) will be evaluated for a given material and
light, thus removing unwanted contribu ons and accelera ng render mes.

Container
The assign container op ons allows the user to assign a material as the container of the camera. By default, it is set to Global Medium but when a camera is
inside an object with a material using medium, the image will render black, unless we assign that speciﬁc material to the container of the camera.
Assign Container: Select the material from the list that will be assigned as a container for the camera.

11. OBJECT PROPERTIES
Thea for Rhino adds Thea proper es to Rhino models. Those a ributes can be conﬁgured by
selec ng the Thea Object Proper es icon.

General
Enable: makes the object invisible. It will also not be visible in reﬂec ons/camera and will not cast
shadows.
Visible: Hides the object from the camera. It will s ll be visible in reﬂec ons and will cast shadows.
Sca er Visible: The object will not be visible in reﬂec ons and refrac ons.
Shadow Caster: Deﬁnes whether the object will cast shadows or not.
Mask Index: Used along with the Mask render channel. Objects with a value greater than zero, will
make Thea for Rhino to generate a separate channel for them when Mask channel is enabled.
Assign Container: Assigns the selected material as a container for the object.

Adap ve BSD
Shadow Receiver: gives to the models the property to get shadows that other models may throw
on them. By disabling it, the model will throw shadows to the rest scene, but will receive no other
shadow.
Caus cs Transmi er: If true, then this surface will produce caus cs on another surface.
Caus cs Receiver: If true, then the surface will show caus cs produced by another one.
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Geometry
Subdivision: Subdivides the surface in render me. Two methods to choose from: Planar or Charles‐Loop. Subdividing a surface can help displacement to
give a be er result. This is especially useful for ﬂat surfaces having a few triangles.
Level: Deﬁnes how many mes the surface will be subdivided.
Weld Ver ces: Welds the ver ces of the selected object.

Back Face Material
Enable: Turns on or oﬀ the back face material support.
Material: Select the material that will be used to the back face of the surface.

Bevel
Enable: Enables/Disables the beveled edges op on.
Angle (degrees): This value allows the user to limit the eﬀect of beveled edges to corners with an angle greater than the one deﬁned here.
Radius (cm): Deﬁnes the radius of the beveled edges in cen meters. When the material of the object uses the Edge Ramp procedural, the same value will
be used for the width of the edges.

Projec on
Projec on: Allows the user to select a custom projec on that will override the texture coordinates of the objects. The default op on will use whatever
mapping is being used from Rhino.
Rota on: Rotates the texture coordinates.

Triplanar
Cutoﬀ/Sharpness: Both parameters control the blending of the projec ons. Values range from 0 to 1.
Note: Projec on and Triplanar op ons act as overrides allowing the user to make changes per object.
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12. RENDER ENGINES
Rendering Modes
Thea for Rhino oﬀers two rendering modes. Interac ve and Produc on mode.

Interac ve Mode (IR)
IR mode allow you to not only render the model as a sta c image but also interac vely move the camera around the model, adjust materials and lights,
modify the model and see the rendering being updated. Engines that oﬀer Interac ve Rendering are: Presto & Adap ve AMC.

Produc on Mode (PR)
PR mode is used for ﬁnal rendering where changes to the scene do not aﬀect the ﬁnal image while rendering. All engines can be used in Produc on Mode
(Presto, Adap ve AMC, Adap ve BSD, Unbiased TR1/TR2)

12.1. PRESTO
Thea Presto is an advanced render engine that has been wri en from the ground up and is
op mised for both GPU and CPU execu on simultaneously, harves ng all your compu ng
power. The engine has been especially tuned for fast interac ve rendering. This pushes
GPU+CPU compu ng to the limits while keeping the high photorealis c quality of Thea
Render.

Presto Se ngs
Tracing Depth: This is an important parameter for Progressive Engines. Increasing this
parameter may be needed for certain cases where there are a lot of mirrors or dielectrics
in the scene but it has a direct impact on render mes.
Diﬀuse Interreﬂec on: is a separate value to control tracing depth for diﬀused surfaces.
Se ng Diﬀuse Depth to 0 will remove all light bounces from the scene leaving only the
direct light.
Extended Tracing: Extended Tracing can eﬃciently render scenes with transparent objects
or materials with Subsurface Sca ering while using a lower Tracing Depth.
Transparency Depth: Determines the Extended Tracing Depth for all transparent materials
like Thin Glass, Glass and Clip Map.
Internal Reﬂec on Depth: Determines the Extended Tracing Depth for transparent
materials that have refrac on and total internal reﬂec on. These materials are created
with the use of the Glass layer (for example solid glass or water). If you no ce that you get
dark areas on solid glass, the cause is o en because of too low Internal Reﬂec on Depth and not due to the Transparency Depth.
SSS Depth: Determines the Extended Tracing Depth for Subsurface Sca ering (SSS) materials. In some cases increasing this value is needed to increase the
brightness of bright colored dense SSS materials. (Not available when Diﬀuse Interreﬂec on is enabled)
Clamp Level: Clamps the evalua on of a pixel, improving an aliasing. The number corresponds to the clamping limit. Higher than 1, clamping becomes less
eﬀec ve for an aliasing while less than 1 it becomes more eﬀec ve but also lowering the brightness of the image more aggresively.
Bucket Rendering: Rendering high resolu on images with mul ple channels is usually an issue for GPUs but with the use of Bucket Rendering
implementa on, we are able to overcome this limi ng factor and improve scalability as well.
Ambient Occlusion: used to mimic a part of global illumina on making the engine to render faster.
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Distance: this is the maximum distance that the sample may be evaluated to an intermediate (gray) color. A er that distance, the sample is evaluated to
white color.
Intensity: this value deﬁnes the intensity of the Ambient Occlusion used.
Denoiser: select the denoiser method to be used. Available methods are NVIDIA Op x and Non Local Means. To enable the denoiser make sure to also
enable the Denoise channel in the Channels tab.

12.2. UNBIASED TR1/TR2
Thea Render supports a superior unbiased core which is one of the most advanced in the market and delivers stunning images without any compromises.
All possible paths of ligh ng transfers are explored, delivering the highest accuracy without any ar facts. Sun‐pool caus cs and terminator ar fact are
robustly handled oﬀering stunning results.

Unbiased TR1/TR2 Se ngs
These two engines have no se ngs and are controlled only by the Sample and Time Limit.
Unbiased engine TR1 is op mal for exteriors and scenes with dominant direct ligh ng while unbiased engine TR2 is op mal for extremely diﬃcult indirect
and caus c ligh ng.

12.3. ADAPTIVE AMC
The Adap ve AMC engine is based on the Unbiased TR2 engine but with shortcuts to
make it faster. It should be preﬀered for diﬃcult indirect ligh ng situa ons (e.g. indirect
caus cs) and it can be used in both Interac ve and Produc on Mode.

Adap ve AMC Se ngs
Tracing Depth: Just like in the Presto Engine, this is an important parameter for
Progressive Engines. Increasing this parameter may be needed for certain cases where
there are a lot of mirrors or dielectrics in the scene but it has a direct impact on render
mes.
Adap ve Bias: Increasing this value, several diﬃcult paths are taken out of
computa ons, making it faster.
Caus cs: Removes the caus cs path. In general, it should always be enabled.

12.4. ADAPTIVE BSD
Thea Biased engine (Adap ve BSD) uses interpola on schemes such as irradiance cache to render in shorter mes and is implemented in a way that more
eﬀort is put where it is needed most. Furthermore this eﬀort is driven by perceptual criteria genera ng high quality results that are perceived naturally.
Adap ve BSD se ngs can be divided in two sec ons. Biased RT and Biased GI se ngs.
Biased RT: contains the basic parameters in order to trace reﬂec ng and refrac ng objects and evaluate direct ligh ng.
Biased GI: contains the basic parameters that control the quality of Global Illumina on.

BSD Biased RT Se ngs
Ray Tracing Quality: deﬁnes the quality of raytracing
Tracing Depth: This is the main parameter inﬂuencing tracing depth for biased engine.
Increasing this parameter may be needed for certain cases where there are a lot of
mirrors or dielectrics in the scene, but it has a direct impact on render me.
Glossy Depth: controls tracing depth for blurred reﬂec ons/refrac ons. Keeping this
value low will save evalua ons on rough materials that in many cases contribute li le
to the overall image.
Trace Reﬂec ons: enables tracing of perfect reﬂec ons (glass reﬂec on and glossy/
coa ng zero roughness reﬂec on).
Trace Refrac ons: enables tracing of perfect refrac ons (glossy/coa ng zero roughness
refrac on).
Trace Transparencies: enables tracing of glass and alpha mapping transparencies.
Trace Dispersion: enables dispersion for biased engine. Dispersion will raise render
mes considerably for the objects that exhibit this property, so having this op on
disabled for quick test renders is preferred.
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Direct Ligh ng: enables/disables the direct light component of the biased engine.
Blurred Reﬂec ons: If enabled, blurred reﬂec ons and refrac ons will be traced in the scene. The maximum tracing depth is set by the ray tracing Glossy
Depth parameter.
Evaluate GI: deﬁnes if Global Illumina on will be evaluated or not.
Min Blurred Subdivs: controls the minimum number samples (in a power‐of‐two rela on) taken on a blurred reﬂec on/refrac on.
Max Blurred Subdivs: controls the maximum number samples (in a power‐of‐two rela on) taken on a blurred reﬂec on/refrac on.
Ambient Occlusion: enables/disables the Ambient Occlusion for biased engine.
Samples: The stochas c samples taken on the hemisphere to es mate ambient occlusion. The more samples the be er the accuracy but it will also take
more me for the computa on.
Distance: the maximum distance that the sample may be evaluated to an intermediate (gray) color. A er that distance, the sample is evaluated to white
color.

BSD Biased GI Se ngs
GI Quality: controls the quality of Global Illumina on.
Scene Type: select between interior and exterior type. Using the interior type will
make the engine to make use of the Field Mapping technique which accelerates
these type of scenes.
Caus cs: Enables/Disables caus cs. Caus cs are the photons that have been
reﬂected or transmi ed via at least one specular surface (like water or glass) before
hi ng a diﬀuse surface.
Captured Photons: This parameter corresponds to caus c photons captured in the
map by all emi ers. Usually, caus cs need to be quite detailed and this value should
be as high as possible. To avoid excessive memory demands, user should also control
the lights emi ng caus c photons and surfaces capturing caus cs, to keep them as
few as possible.
Es ma on Photons: This is the number of caus c photons used for irradiance es ma on. The higher the value the more blurry the results. Note that
increasing this value will also have an impact on render mes.
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